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1) Open and navigate through multiple Word documents    

Exercise: Open three documents from the Group 1 folder and navigate through them with your mouse. 

• Open the following Word Documents from your desktop: “A.Nordic Cuisine”, “A.Nordic Cuisine 

2”, and “A.Sidebars”. 

• You will probably see only one document on your screen but all are open. 

Notice the word icon on the taskbar is highlighted.  

• Put your cursor over the Word icon. Thumbnails of all three documents will 

pop up. To switch between Word documents, simply put your cursor on this icon and then click 

the thumbnail of the document you wish to work on.  

 

• To close a document click the “X” (outlined in red above) that appears in the upper right of the 

thumbnail. 

Exercise: Use the keyboard to switch among multiple word documents. 

• While holding the alt key down (use the one just left of the spacebar) select the tab key. All of 

your open windows will display, including Word documents. 

• You will change windows, each time you hit the Tab key. When you get to the Word document 

you want, release the Alt key. 

2) Combine two separate documents into a single document 

Exercise: Combine the “A.Nordic Cuisine” and the “A.Nordic Cuisine 2” documents into a single 

document. 

• Look at each document. They have different headers and page number placement. 

• Begin at the “A.Nordic Cuisine” document. Place your cursor at the end of the text (page 3). Hit 

the Enter key to add a space after the last line. 
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• Select the Insert tab and then click the arrow next to the Object command on the right of the 

ribbon.  

• From the drop-down menu, click “Text from file.”  

 

 

 

• From the popup box that opens, direct to the “A.Nordic Cuisine 2” document (within the Group 

1 folder). 

• Highlight it and click Insert. This will combine the two documents. 

• Notice the formatting adjusts to that of the first document. All headers and page numbers 

adjust accordingly. (This does not work with the actual text. If the second document had a 

different font, you would have to change the font to match the first). 

• The “A.Nordic Cuisine 2” document changed its margin and page number to match “A.Nordic 

Cuisine.”   

3) Create clickable Word links inside your document 

You can create links within your documents to web pages or to elsewhere inside your document. 

Exercise: Link the word “Denmark” to the website of the country of Denmark. 

• Highlight “Denmark” on the third line of the second paragraph in the document. 

• Select the Insert tab and then click the Hyperlink command.  

• Type http://www.denmark.dk in the address box of the popup window and then 

click the OK button. 

• Notice the Word Denmark is now highlighted blue and underlined.  

• Hold the Ctrl key and then click “Denmark” to access the website. 

• If you want to remove or edit a hyperlink, the easiest way to do so is 

to right click the link and select the appropriate options from the 

menu. 

 

Exercise: Create a bookmark for the word “berries” in the document. 

• Highlight the bold word Berries (It should be in bold at the top of 

page 6) before the list and description of common Nordic berries. Then click the Bookmark 

command (next to Hyperlink).  

 

• In the popup box type Berries and then click the Add button. 

• Next find the word “berries” on the first page (the last word of the paragraph above the bold 

text: Noma. 
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• Highlight the word and then click the Link command.  

• Click the Bookmark button at the right of the first popup box, select “Berries” in the second 

popup box, and then click OK twice. 

 

 

 

 

 

 

 

• Now hold the Ctrl button and click “berries” on the first page. When you do so, you will move 

down the document to the list of berries (p. 6). 

4)  Mirror Margins  

Exercise: Create a 2-inch gutter for this document and prepare it to print double sided for a three-ring 

binder. 

• Select the LAYOUT tab, click the Margins command, and then select “Custom Margins” at the 

bottom. 

• Change the size of the gutter to 2 inches and align it to the left. 

 

• Click OK. Go into print preview and select Print on Both Sides. Suppose we wanted to print this 

document and put it in a three-ring binder. What is the problem with the current print job? 

• Go back into Custom Margins. Under “pages’ change from Normal to Mirror Margins. Notice the 

difference in the gutter in the Preview. 

 

 

 

 

 

 

 

 

 

• You can see the difference when you go into Print Preview. Go back to the LAYOUT tab and 

remove the gutter (or undo) before part 5.  

• Click undo twice to remove gutter prior to next section. 
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5)  Word Art  

WordArt is a gallery of text styles that you can add to your publications to create decorative effects, 

such as shadowed or mirrored (reflected) text.  

 

Exercise: Use WordArt to create an artistic title at the top of the document. 

• Delete the current title at the top, and then hit the Enter key about 

5 times to leave space at the top.  

• From the INSERT tab click the WordArt command and then select 

the first option (but notice the other ones you can use).  

• In the box, that reads “Type your text here” type Nordic Cuisine. 

Move WordArt by clicking and holding the dotted line around the 

text. 

• While working on the WordArt, you will have access to the Shape 

Format tab at the top of the ribbon. Highlight the text. Then click the Text Fill command and 

select yellow (or another light color).  

• Do the same with the Text Outline command but select dark blue (or another dark color). 

• Click Text Outline again and then select “Weight.” In the second menu that pops up choose 1.  

• Now let’s examine Text Effects. Experiment with some of the different effects to see how they 

look (shadows, glow, etc.). 

• Under Text Effects choose Transform and then choose “Chevron Up.” 

• When you use a text effect, you can change the size by using the outline around 

a text box (as you would with an image).  

 

 

6)  Add a sidebar or textbox  

Exercise 1: Create a sidebar on the right side of first page by adding a text box.  

• From the INSERT tab, click the Textbox command toward the right. A menu of 

built-in templates will appear.  

• Select the “Banded Sidebar” option (the fifth on the list). It will appear on the 

right of the page. This option already has text wrapping so it will not interfere 

with the regular text in the document. ** 

• Click and hold the top line of the box and drag down so that it is not in front of 

the title in order to align it with the first sentence. 

• Type “Nordic Countries” over “Sidebar Title” at the top. Then copy the text 

from part 1 of the “A.Sidebars” document and paste in the body portion of the 

sidebar.  

• We will need to widen the sidebar slightly to fit all the text. Widen the box so that “ambiguous” 

shows as the last word in the sidebar.  
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** If you draw the text box, you will need to adjust the text wrapping to square so that the main text of 

the document will fit around the box. 

Exercise 2: Create another sidebar with the “Simple Text Box” 

• Go to the lower right of page 5 of the document. Choose “Draw Text Box” from Text Box 

command. With the black plus sign, draw a text box roughly 1” tall and 2” wide. 

• From the wrap Text command choose “square.”  Then copy the text from part 2 and paste into 

the box. Make the top line (Did you know?) bold. If you need to, adjust the size or move the box. 

• Change the background color of the text box. Click the Shape Fill 

command from the Drawing Tools tab and choose a light gold or yellow 

color. 

• Click Shape Outline from Drawing Tools and choose black.  

 

7) Foreign Languages and Translation 

Exercise 1: Set the proofing language for a paragraph in a foreign language. 

• Notice that the paragraph under Noma is in a foreign language (Spanish). Most of the sentence 

is underlined in red because Word does not recognize the words. Highlight this paragraph. 

• From the REVIEW tab, select the Language command. Then choose “Set proofing language.”  

• Change the proofing language to Spanish (Spain) and then click OK.  

• If available, the spelling and proofing tools automatically 

use dictionaries of the selected language. (If you see the 

ABC symbol). 

 

• Right click the word “restaurante” and correct the spelling 

with the first option on the list. (The correct spelling in Spanish is “restaurante”). 

Exercise 2: Translate the Spanish paragraph into English with the Translate command. 

• First, highlight the entire paragraph under Noma. 

• Select the REVIEW tab and then click the Translate command. Then 

choose “Translate Selection” (the second from the list). Click “Yes” in 

the popup box. A task pane will open to the right. 

• In the task pane, change From to Spanish and change To English with 

the drop-down arrows. 

• Click the Insert button under the translation in the task pane. (You 

might need to fix the spacing between this paragraph and the one that 

follows). 

• Read over the translation. How good is the translation?  
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8. Heading Styles and Table of Contents 

To make a Table of Contents in Word, we will use the headings from the HOME tab in the Styles group. 

 

Exercise 1: Create an automatic Table of Contents from the “B.Nordic Cuisine Full” document. 

• Open the document “B.Nordic Cuisine Full” in Group 2. This is the previous document but 

without the WordArt, sidebars, and links. 

• Click on the title: The Rise of Nordic Cuisine. Then click the Heading 1 command. Note the 

change in the Title text. We can change the text style and color – but for this first exercise, we 

will leave it as is. 

• Click the next bold text in the document (Noma). Then click Heading 2. Click this heading for the 

remainder of the bold text in the document (again, no 

need to change the font or color). 

• Click before the title so that the blinking cursor shows.  

• Click the REFERENCES tab and then click the Table of 

Contents command at the left.  

• Select the first option on the list: Automatic Table 1.  

• The Table of Contents will insert. In the next exercise, we 

will create a Table of Contents before the document. 

(Undo all the changes before proceeding). 
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Exercise 2: Create a Table of Contents before you write your document (with three levels of headings). 

Begin by adding chapters, sections, and subsections: 

• Open the “B.TOC” document in Group 2. It will be blank except for a paragraph of filler text. 

(Filler text is also known as dummy text). Copy the filler text so that you can paste it elsewhere 

in the document. 

• Add Chapters: Type “Chapter 1” above the filler text.  

• Below the filler text, type “Chapter 2” and then paste more filler 

text below. Type “Chapter 3” and add more filler text.  

• Add sections: Type “Section 1” under the Chapter 1 paragraph 

followed by filler text. Then add “Section 2” followed by filler 

text.  

• Do this for Chapter 2 (Section 1 and 2 along with filler text). 

• Add subsections:  Under Chapter 2/Section 1 add subsection 1 

and subsection 2 followed by filler text. Your text should 

resemble this outline (minus the filler text). 

 

 

Set up headings and subheadings: 

• Click on Chapter 1. Then click Heading 1 in the Styles) in the HOME tab.  

• Highlight Chapter 1. In the Font Group change the font to Times New Roman; change the text 

size to 20; and change the text color to black. 

• Make this the default font for Heading 1 font. Right-click the Heading 1 command and choose 

“Update Heading 1 to Match Selection.” 

 

 

 

 

 

• Click Chapter 2 and then Heading 1 to update the font. Do the same with Chapter 3.  

• Click Section 1 and then click Heading 2. Change the font to Times New Roman; change the size 

to 16; and change the color to black. Make this the default font for Heading 2 in the same 

manner as we did with Heading 1. Then change the other Sections. 

• Now let’s do the subsections as Heading 3 with the same font as the others, the size 12, and the 

color black. (If you don’t see Heading 3 on the ribbon, click once on Heading 2 to bring it up).  

• Highlight the first filler-heading paragraph. Click the Normal command. Make the default font 

Times New Roman and keep the other settings.  All the text should change to this font. 
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Create the Table of Contents: 

• Add a line of space at the top right before Chapter 1. From the REFERENCE tab, click the Table of 

Contents command and then select “Custom Table of Contents” at the bottom. 

• From the pop-up box, we can modify the Table of Contents.  

• Note the General Section at the bottom. Click the arrow next to Formats: Select “Classic” from 

the list and look above for the preview of what the Table of Contents will look like. Try some of 

the other options as well.  

 

 

 

 

 

 

 

 

 

 

 

• Select “Classic.”  

• Change the Tab Leader to the solid line (the last option). 

• Click OK to insert your table of contents (see below).  
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Update the Table of Contents: 

• When you are ready to begin your document, you can replace the headings and filler text with 

the actual subject matter.  

• Replace Chapter 1 in the text with “Denmark”; Chapter 2 with “Finland”; and Chapter 3 with 

“Iceland.” Replace Sections 1 and 2 with “People” and “Cities.” Right click the Table of Contents 

and choose Update Field from the list.  

 

 

 

 

 

• To add another chapter: At the end of the document type Norway and set it to Heading 1. 

Update the Table of Contents again. 

• Open the “B.Text” document in Group 2. Use the keyboard shortcut Ctrl-A to highlight all the 

text. Copy and paste over the first paragraph under Denmark. Update the Table of Contents. 

• Whenever you make document changes, make sure to update it in the Table of Contents. 

• The items in the Table of Contents are also links! Hold the Ctrl button, click Iceland, and see 

what happens. 

9) Create an Index 

Exercise 1: Select words from your document as main entries.  

• Go back to the “B.Nordic Cuisine Full” document. 

• Find the index group In the REFERENCES tab. 

• Highlight “Denmark” on line 3 and then click the Mark Entry command.  

• Keep Denmark as the main entry. Click the Mark All button so 

the index will access “Denmark” on all pages in which it is listed. 

• Leave the Mark Entry window open at the side of the text. 

• (Click Mark, if you only want to index that word one time). 

• Notice the formatting next to “Denmark”: 

 

• Now let’s select 8-10 more words from the text to add to the 

index as main entries. Focus on terms related to places and food 

(with the exception of Berries which we’ll do next exercise). 

• Whenever you highlight a word, click the Mark Entry Window so 

it appears in the Main entry box. Click Mark All for each word. 

• After you have added about 8-10 words, click the Close button. 
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Exercise 2: Create a Main Entry with several subentries for the index. 

• Find Berries near the end of the document (the word is highlighted red to make it easier to 

find). Five berries are listed (cloudberries, strawberries, lingonberries, elderberries, and 

blueberries). 

• Highlight the first term “cloudberries” and then click Mark 

Entry. Use Ctrl-X to cut the term from Main entry box and 

then Ctrl-V to paste into the subentry box. 

• Type “berries” in the Main Entry box and then click Mark All. 

• Highlight the next berry - strawberries - and click the Mark Index box. Repeat the previous steps: 

Cut “strawberries” from the Main entry, paste into the Subentry box, type “berries’ in the Main 

entry box, and click Mark All.  

• Do the same with the other three berries and then click Close when finished. From Home tab, 

click the Show/Hide command to remove the formatting text.  

Exercise 3: Complete the index with the entries you have selected in a “Modern” 

style. 

• Click at the end of the document so that you have a blinking cursor. Click 

the Insert Index command. 

• From the Popup window, change the Format to Modern. Check the box 

marked “Right align page numbers.” 

• Click OK and your index will appear (it should look something like the 

index at the bottom of this page.  

• If you create more entries to add to the index, right-click the index and 

select Update Field.  
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10) Insert a date that updates automatically daily 

• Open a new Word document. 

• Click just after the text “Date:” on the upper left of the document.  

• From the INSERT tab, select the Date & Time command. 

• Notice the number of date formats in the popup box. Select the third option.  

• Make sure to check the Update automatically box in the lower left.  

• Click OK. Today’s date will insert and it will change every day. 
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Recommended Additional Resources:  
Other technology classes 
Go to http://www.eapl.org/events to view and signup for other computer classes. 
 
Class handouts 
Download copies of class handouts and materials for all of our computer classes at: 
http://eapl.org/events/computer-programs/class-handouts . 
 
Librarian and computer aide assistance 
We are glad to help you out at the second floor reference desk as best we can while helping others. 
 
Help appointments 
Ela Library cardholders can schedule one-on-one appointments with librarians for further help. We can 
help with our Digital Media Labs or with general technology questions in our areas of expertise. 
Appointments last up to one hour. Paper appointment request forms are available at the 2nd floor 
reference desk. You can also request appointments online: 

• Go here http://www.eapl.org/DMLhelp to sign up for a Digital Media Lab appointment. 

• Go here http://www.eapl.org/computer-programs/one-one-technology-help-appointment-
request to request a general tech help appointment. 
 

Databases 
The Library offers card holders access to many premium databases. These include two which can help 
you learn more about technology. 

• Gale Courses offers a wide range of highly interactive, instructor led courses that you can take 
entirely online. As an Ela Area Public Library card holder in good standing, you are entitled to 
these courses at no cost. Courses run for six weeks and new session begin every month. 

• Lynda.com offers technology training with over 20,000 training videos on over 300 topics with 
exercise files included. The Library pays for you card holders in good standing to access this 
resource, however you will be required to create a free account. *Please remember to log out 
when you are finished. 

Access both of these databases from the library Research page: http://www.eapl.org/resources  
 
Books 
A few books in the library collection related to this book are: 

• Microsoft Word 2016 step by step by Joan Lambert (Call Number: 005.52 WORD) 

• Microsoft Office Word 2019 for Dummies by Dan Gookin (Call Number: 005.52 WORD) 
 

Free online tech training websites 
http://www.gcflearnfree.org/ , https://techboomers.com/ , http://digitallearn.org/ 

 

 

 

http://www.eapl.org/events
http://eapl.org/events/computer-programs/class-handouts
http://www.eapl.org/DMLhelp
http://www.eapl.org/computer-programs/one-one-technology-help-appointment-request
http://www.eapl.org/computer-programs/one-one-technology-help-appointment-request
http://www.eapl.org/resources
http://www.gcflearnfree.org/
https://techboomers.com/
http://digitallearn.org/
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Computer Class Evaluation 
 

Class Title:  Word 3 Date:  3/24/2022 
In terms of your skill with computers, how do you consider yourself? 
 
□ Absolute Beginner 
□ Beginner   
□ Intermediate  
□ Advanced 
 
In terms of your skill using Microsoft Word, how do you consider yourself? 
 
□ Absolute Beginner (no experience) 
□ Beginner (some experience, but not comfortable using) 
□ Intermediate (some experience, comfortable with the basics) 
□ Intermediate/Advanced (experienced with basic and intermediate functions, but require 
   training on advanced functions) 
 
How much do you feel that you learned? 
 
□ I learned a lot     
□ I learned some       
□ I didn’t learn much      
□ I learned nothing  
 
How did you perceive the pace of the class? 
 
□ Too Fast 
□ Just Right 
□ Too Slow 
 
Were the handouts helpful? 
 
□ Yes   □ No      If no, why not? 
 
What did you like most about the class? 
 
 
What did you like least about the class? 
 
 
What other topics would you like to see in a future computer class? 
 
 
How do you normally find out about library computer classes? 
 
□ Footnotes (Library Newsletter) 
□ Library Website 
□ Other  __________________________________ 
 
If you are not an Ela Area Public Library card holder, where is your home library? 
 
 
Any additional comments: 


